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Inside Information...

About the Information Alley

The Information Alley (I is a
publication of Apple
Computer, Inc., Support
Information Services. The
goal of the Information Alley
is to help you get full use of
your Apple computers,
peripherals, and software.

Where to Find the Information
Alley

The Information Alley is
available to anyone through a
variety of online services and
Internet list server capability.
For a complete list of where
to find the Information Alley,
call the Apple Fax line at 1-
800-505-0171 and request
document #20720. You can
also get an index to back
issues by requesting
document #20719.
Optionally, you can search
the Technical Information
Library; use “information
alley” as the search string.
Select article title /nformation
Alley: Online Services it is
Posted To or article title
Information Alley: Index of
Past Issues.

Submissions and Letters

We welcome articles that
help Apple computer users
become more knowledgeable
about the functionality of their
systems, explain or illustrate
complex features or
functions, or that describe
technical tips or techniques.
Send submissions to:

Information Alley

Apple Computer

1200 East Anderson Lane
MS 212-STI

Austin, TX 78752

Fax: (512) 908-8018
email: alley@apple.com

We also welcome letters to
the editor and suggestions
for future articles. Please
send all letters to the
preceding address.

Copyright Notice

This newsmagazine is
copyrighted, with all rights
reserved. Individual articles in
this newsmagazine may be
reprinted, in their entirety,
without prior written
permission from Apple as long
as full credit is given to Apple
Computer and the Information
Alley is listed as the source of
the information.

You must have prior written
permission from Apple
Computer to excerpt or
paraphrase portions of articles
from this newsmagazine. For
permission, contact:

Janet Christian, Editor
Information Alley

Apple Computer

1200 East Anderson Lane
MS: 212-STI

Austin, Texas 78752

Voice: (512) 908-8975
Fax: (512) 908-8018
email: alley@apple.com

Trademarks

The Apple logo is a trademark of
Apple Computer, Inc., registered in
the U.S. and other countries.

Apple, the Apple logo, APDA,
AppleLink, AppleShare, AppleTalk,
A/UX, EtherTalk, HyperCard,
HyperTalk, ImageWriter,
LaserWriter, LocalTalk, Macintosh,
and ProDOS are trademarks of
Apple Computer, Inc., registered in
the U.S. and other countries.

Apple Desktop Bus, Balloon Help,

Disk First Aid, Finder, SuperDrive,
Information Alley, “Get off the
Highway and Into the Alley”, and
TrueType are trademarks of Apple
Computer, Inc.

Classic is a registered trademark
licensed to Apple Computer, Inc.

AppleCare is a service mark of
Apple Computer, Inc., registered in
the U.S. and other countries.

All other products mentioned in this
newsmagazine are trademarks of
their respective companies.
Mention of third-party products is
for informational purposes only and
constitutes neither an endorsement
nor a recommendation. Apple
assumes no responsibility with
regard to the performance of these
products.

Apple Computer, Inc., products
(hardware and software) described
in this newsmagazine are subject to
update and change. This news-
magazine makes no assurance that
functions and technical information
described here is not superceded
by subsequent releases of the
product described.

The Information Alley is produced
using FrameMaker 4.0 on a Power
Macintosh running System 7.5. @&
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Thoughts from the Alley Cat (Editor)

Happy New Year!

By Janet Christian
Ready or not, it is now 1995!

Time certainly flies — and it really does
seem to go faster the older one gets.
Most of us like to think that we improve
with the passing of time. We certainly
hope this is true with the Information
Alley.

New Page Jumping Capability

We continue to make minor
modifications and improvements based
on your feedback. For example, for
those using Adobe Acrobat to read the
Information Alley, you will find that you
can now click on the Continued on
next page/Continued from previous
page messages to “jump” to the next or
previous page, respectively.

Article Suggestions

We also continue to use your article
suggestions when we are selecting
articles for each issue. In addition, your

.3

suggestions have helped us to improve
and expand the content of our Technical
Information Library (TIL), which is
either the source or ultimate destination
of all articles that appear in the
Information Alley.

Expanded Information Alley
Availability

The list of online services and Bulletin
Board Systems (BBSs) that offer the
Information Alley continues to grow. As
of this issue, the Information Alley is
now carried on 16 online services and
28 BBSs. To obtain a master list of these
locations, see Where to Find the
Information Alley on the previous
page. Also, if you are now carrying the
Information Alley on your BBS and have
not let us know, please send us an email
or give us a call so that we may include
the listing in the New Places to Find
the Information Alley column and add
the information to our master list.

Japanese Translation Update

The Japanese versions of Information
Alley issues 9 through 17 are now being
uploaded to eWorld, Compuserve,
America Online, Genie, the Internet,
Apple’s World Wide Web server, and
AppleLink. We will continue posting
future issues as they are translated.
Many thanks again to the TwoByter
group for their hard work and
dedication in this undertaking.
Remember, you must use either the
Japanese Language Kit or KanjiTalk )
operating system to read these issues. @
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Power Book 150 Common Questions and Answers

By Joe Azzato

This article describes common
PowerBook 150 questions and answers
compiled by the PowerBook support
team in the Apple Assistance Center.

Q: What are the PowerBook 150 features?
A: The PowerBook 150 features:

e Motorola 33-MHz 68030
microprocessor

e 9.5-inch (diagonal), backlit,
passive-matrix, grey-scale display
(four levels of gray)

e High-capacity internal IDE 120MB
hard disk drive

¢ Includes slots for internal modem
and additional RAM (up to 40 MB)

e Serial port for external devices
and LocalTalk networking

e Built-in floppy drive

e External SCSI port for connecting
up to 6 SCSI devices

e Integrated trackball and palm rests

Q: What does my PowerBook 150 weigh?
A: The PowerBook 150 weighs 5.5
pounds.

Q: When I press the power button, my
PowerBook does not start up, or

flashes the display momentarily.
What is wrong?

A: There are a couple of things that you
need to try. Follow these procedures:

e Plug in the AC Adapter. If the unit
starts with the AC Adapter, but
not with the battery in the battery
compartment, you either need to
charge the battery, or you may
need to replace the battery.

e Follow these steps to reset the
power management circuitry:

STEP ACTION

1 Remove the PowerBook
battery and AC adapter.

2 Use a paper clip to push the
“reset” button on the back of
the unit (in the small hole
with a triangle symbol above
it, near the power button).

3 Hold the in the reset button
for 25 seconds, then release.

4 Reinstall the PowerBook
battery and AC adapter.

5 Press the reset button again
and immediately release it.

The PowerBook should power on
normally.

e If the machine does not start with
a recharged or new battery, or
does not start with the AC Adapter
alone (with the battery removed),
your PowerBook may need
servicing. Please call 1-800-SOS-
APPL or see your local Apple
Authorized Service Provider.

Q: My battery lasts only a very short
time. What can I do?

Continued on next page...
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A: Follow these procedures:

Pg. 5

STEP ACTION

1 Reset the power manager,
following the procedure detailed
in the preceding question and
answer.

2 Let the battery charge for eight
(8) hours. This procedure should
resolve the problem.

after approximately 15 to 20
recharges.

3 Completely discharge the battery

How to Completely Discharge a
Battery

Let the battery discharge until the
PowerBook goes into sleep mode.
Three battery warning dialog boxes
appear before this occurs. This

process “recycles” the nickel cadmium

(NiCad) battery and eliminates a
“‘memory effect”, which makes the
battery appear depleted when it is
not.

Q: Since I installed a modem, the
battery seems to get depleted very

quickly. What can I do to save battery

power?
A: Apple released the PowerBook 150

Update to correct this problem. When

the PowerBook 150 has an internal
modem, the modem continues to
draw power when not in use. This

shortens the battery life. The update

is available through online services
on which Apple publishes software
updates. (See Apple Software

Updates in Information Alley Volume
[ Issue 13 for a list of these services.)

Q: My PowerBook 150 does not always
eject floppy disks; what is the
problem?

A: The drive may not be properly
aligned. If you can see the metal

frame sticking up more than a couple

of centimeters behind the floppy

drive door, you should either have an
Authorized Apple Service Provider
adjust this, or call the Apple
Assistance Center to arrange for this
repair.

: I just bought my PowerBook 150 and

the battery is missing. How can I get a
replacement?

: Check the packaging. The battery is in

the accessory box. An extra door over
the battery compartment keeps dirt
out; the battery is shipped separately
to prevent draining the battery charge
during shipment.

: My PowerBook 150 display is blurry

or sometimes has shadowing and
ghosting effects. What can I do to
correct this?

: Open the Monitors control panel and

select Black & White instead of 16
Shades of Gray. The type of screen
technology used on the PowerBook
150 models is susceptible to
shadowing and ghosting, since it does
not individually address each pixel on
the display. These effects are less
noticeable in Black & White mode,
but cannot be eliminated completely.
You can also adjust your brightness
and contrast controls to minimize
these effects.

: I try to use SCSI Disk Mode on my

PowerBook 150, and it does not seem
to work. What is wrong?

: That mode is not supported on the

PowerBook 150. It is supported in
many other PowerBook models, but
not in the PowerBook 150.

: Can [ hook up an external monitor to

my PowerBook 1507?

: Apple does not provide a solution for

external monitor support on the
PowerBook 150. There may be third
party vendors who provide devices
to do this. Apple recommends
checking with your Apple reseller or
trade magazines. @
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Recealving eWborld Mail on Your Newton

By Brian Schussler

This article describes how to setup your
Newton to receive electronic mail from
your eWorld account.

Setting Up Your Newton

Follow these steps to set up your
Newton to receive mail from your
eWorld account:

ACTION

5 System ID: Make sure it says
Newton.

6 Network: Normally this should say
SprintNet, but some areas require
using and MCI/Tymet number. If you
are calling from outside the
continental United States, see the
section titled International Calling.

7 E-mail Account: Your eWorld name.

8 Tap on Set E-mail Password and
enter your eWorld password.

9 Close all open views by tapping on
close box in the lower right corner of
the touchpad until the Notepad is the
only item on the screen.

You are now ready to connect to the
eWorld host and get your mail. Make
sure the Newton is connected to a
NewtonModem, and the modem is
connected to a standard (analog) phone
line.

Note:Apple officially supports
connections only with the
NewtonModem and Newton
PCMCIA Modem.

Receiving Mail

STEP ACTION
1 Tap on Extras
2 Tap on Prefs
3 Tap on Mail
4 Enter Phone Number: Enter your

local 2400 bps access number
(normally a SprintNet number). If you
are uncertain what number to use,
contact Apple Online Services
Support at (800) 775-4556. If you are
simply changing locations, you can
check access numbers on eWorld
prior to relocating. Access numbers
are available on eWorld in the Info
Booth (Shortcut Help) in the eWorld
Assistance Center under eWorld
Network Directory.

STEP ACTION
1 Tap Extras
2 Tap InBoxReceive
3 Tap Mail

The Newton attempts to connect and
download all your unread mail
messages.

Continued on next page...
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International Calling

If you are in Canada, Alaska or Hawaii,
you need to use MCI to connect. This
requires the NewtonMail Update 1.01. If
you do not have this, it is available on
eWorld. Use the Shortcut Newton. The
update is available in the Software
Exchange/Official Apple & StarCore
Software/Newton System Updates.

If you are calling from a country outside
the US, you can determine which phone
carrier is used in your country from the
eWorld Network Directory in the Info
Booth. It only lists the carrier and
numbers appropriate for your country.

Questions or Problems

If you have any questions or problems
establishing a connection, please
contact Apple Online Services Support
directly at the eWorld address MAIL or
(800) 775-4556. @

New Placesto Find the

| nformation Alley

You can now find the Information
Alley on these online services and
BBSs:

e Mac’s Last Stand BBS (Rochester,
New York) - (716) 346-5555

Includes 12 lines at 28,800 bps
US Robotics V.Everything, 13 GB
disk, 800 conferences, 600,000
files, and 13 CD-ROMs.
International gateways to OneNet,
Internet, and Fidonet. Full
graphical interface for all
computers. Eight bits, no parity,
one stop bit. The system prompts
you for all information. @

System 7.5

ExtraltemsInstalled
with Custom Install

By Daniel Carr

When installing System 7.5 with the
Custom Install option and selecting for
this Macintosh, you get files for other
Macintosh computers as well.

The problem is that a top level check
box item (the one that has a triangle to
the left of it) installs items for all
machines, regardless of whether you
have already selected a secondary
checkbox item for a specific Macintosh.

Oftentimes, users “instinctively” make
the following selections:

e System Software for this
Macintosh only

e Apple Menu Options
e Control Panels

The Installer interprets these requests
as “System Software for this Macintosh
only” plus “All Apple Menu Items” plus
“All Control Panels”. This situation can
be avoided by clicking on the triangles
next to the top level check boxes to
reveal the second level check box items.
It is at this point (the second level)
where you should specify which items
should be installed.

For this particular scenario, note the
following:

e Selecting System Software for this
Macintosh only by itself achieves
the desired result.

Performing an “Easy Install” is much
easier. It is the recommended way to
install the needed System software, and
not install any unnecessary System
software. @
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System 7.5 Clean I nstall

By Mark Hansen

This article describes how to do a clean
system folder install under System 7.5
without having to remove the Finder or
System file and renaming the system
folder.

Purpose of a Clean Installation

A normal system software installation
modifies and updates the existing
System Folder. A clean installation
disables the existing System Folder,
leaving all files in place, and forces the
Installer to create a new System Folder.

A clean system installation brings the
system software back to the standard
configuration. This is necessary when
system software has been damaged or
modified, preventing a normal
installation. It is also useful in
troubleshooting.

Perform the following steps in the order
specified:

Step 1 - Restart with Disk Tools or
Apple Macintosh CD:

e If you have a Disk Tools Disk:

STEP ACTION

1 Shut down your Macintosh
computer.

2 Insert Disk Tools in the floppy
drive, and turn on the computer.
At the desktop, the Disk Tools
floppy disk’s icon should be in
the upper-right corner of your
screen with your hard drive’s icon
below it.

3 If the computer ejects the disk,
make sure you have an Apple
SuperDrive (formerly FDHD) that
reads high-density disks, and that
you are using the System 7.5 Disk
Tools.

e If you have an Apple Macintosh CD
that came with your computer:

STEP ACTION
1 Insert the Apple Macintosh CD in
the CD-ROM drive.
2 Restart the Macintosh.
3 If you have a Power Macintosh or

a Macintosh 630 series computer,
hold down the letter C on the
keyboard and turn the computer
on.

If you have a Macintosh 570
series computer, turn on the
computer and immediately hold
down the %-Option-Shift-Delete
keys simultaneously. Keep these
keys down until you see the
Welcome to Macintosh
message. At the desktop, the
Apple Macintosh CD’s icon should
be in the upper-right corner of

Continued on next page...
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STEP ACTION

3 your screen with your hard
Cont. | drive’s icon below it. If any other
hard drives appear above the
Apple Macintosh CD, shut down
the computer and all attached
devices, and remove the large
SCSI cable from the rear of the
Macintosh and try again. If the
internal hard drive still appears
above the Apple Macintosh CD, go
to the Control Panels under the
Apple Menu, open the Startup
Disk item, select the Apple
Macintosh CD, close all open
windows and restart. The Apple
Macintosh CD should then appear
above the hard drive.

Pg. 9

Step 3 - Update Hard Disk Drivers

If you do not have an Apple hard drive,
or you use third-party software to
format your hard disk, do not use the
Apple HD SC Setup utility. You should,
however, contact your hard drive
vendor to verify that your formatting
software is compatible with system
software version 7.5.

If you have an Apple hard drive, you
should update the drivers with the
version of Apple HD SC Setup that is on
the Disk Tools disk, following these
steps:

STEP ACTION

Step 2 - Run Disk First Aid

Disk First Aid can detect and repair
problems with a hard disk.

1 Disk Tools users: Double-click the
Apple HD SC Setup icon on the Disk
Tools disk. Apple Macintosh CD
users: Double-click the Apple HD SC
Setup icon in the Utilities folder.

2 Click the Update button.

STEP ACTION

3 When you are finished, click Quit to

return to the desktop.

1 Open the Disk Tools disk or the
Apple Macintosh CD. Apple
Macintosh CD users should open the
Utilities Folder.

2 Double-click on the Disk First Aid
icon. Select the main hard drive’s
icon at the top of the Disk First Aid
window.

3 Click Repair. Disk First Aid checks
your hard disk for any potential
problems and attempts to fix them if
necessary.

4 Repeat this procedure for each hard
disk attached to the system.

5 When you are finished verifying the
hard disks, choose Quit from the File
menu to return to the desktop.

If Disk First Aid cannot repair a hard
disk, you should back up the hard disk
and reinitialize it using the appropriate
formatting utility for that drive. For
Apple drives, use Apple HD SC Setup.

Sometimes HD SC Setup cannot update
the hard disk driver (indicated by a
“‘“dimmed” Update button). Here are
some possible causes and solutions:

e If a third-party utility formatted your
hard disk, you should obtain the latest
version of the utility to update your
hard drive.

e If a version of Apple HD SC Setup
more recent than the version on the
Disk Tools disk formatted your hard
drive, do not update the hard disk
drivers.

e Your Macintosh has an internal IDE
drive. Currently this only applies to
the PowerBook 150 and Macintosh
630 family computers. Skip this step
unless you have a second Apple SCSI
hard drive.

Continued on next page...
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e If an earlier System 6 version of Apple
HD SC Setup formatted the drive, it
may not have left enough room for the
updated driver. You do not have to
update the hard disk drivers. However,
if you intend to use file sharing or
have a Macintosh that can use virtual
memory, then you need to back up the
disk and reinitialize it with the current
version of HD SC Setup. This erases
the disk, so be certain you back up the
hard disk first.

e If the driver is corrupt, the Macintosh
does not recognize the drive (that is,
the drive does not show on the
desktop when you start from a floppy
disk). You may wish to reinitialize it
with HD SC Setup. This erases the
disk, so be certain you back up the
hard disk first.

Step 4 - Check Available Hard Disk
Space

Be sure you have at least 21 MB (to
install the complete system, including
PowerTalk and QuickDraw GX) available
on the hard disk where you plan to
install the system software. Open the
hard disk’s window and select by Icon
in the View menu. The amount of
available disk space appears in the
upper-right corner of any open window.

If there is less than 21MB available, you
need to delete some unnecessary files
by moving them to the Trash. Choose
Empty Trash from the Special menu,
and you have more disk space available.
If you want to keep the files, copy them
onto floppy disks or other media before
moving them to the Trash.

Step 5 - Install System 7.5
e From Floppy Disk:

STEP

ACTION

1 You are done with the Disk Tools
disk so choose Shutdown from
the Special menu. The disk
automatically ejects.

10

STEP

ACTION

Insert the Install Disk 1 disk into
the Macintosh and turn the
computer on. The computer
starts up with the system files on
the Install disk.

When the Welcome to System
7.5 message appears, click
Continue.

When the installer window
appears, press the 38-shift-K
keys simultaneously. You are
presented with a small dialog box
with two selections:

¢ Update Existing System Folder
¢ Install New System Folder

For a Clean install, select Install
New System Folder and click
OK. Make sure the Destination
Disk on the bottom left is the
disk you want to install on, then
click Clean Install on the bottom
right. This installs a new System
folder and renames your current
folder to Previous System
Folder.

Insert the other disks when the
Installer instructs you to.

e From the Personal Upgrade Kit CD-

ROM:

STEP

ACTION

1

Insert the Macintosh System 7.5
CD-ROM into the Macintosh.

Open the Macintosh System 7.5
CD-ROM by double-clicking on it’s
icon in the upper right corner of
the screen.

Open the Installation folder.

Open the System Install folder.

Double-click the Install icon.

| LT | W

When the Welcome to System
7.5 message appears, click
Continue.

Continued on next page...
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STEP ACTION

7 When the installer window
Cont. | appears, press the 8B-shift-K
keys simultaneously. You are
presented with a small dialog box
with two selections:

e Update Existing System Folder
e Install New System Folder

For a clean install, select Install
New System Folder and click
OK. Make sure the Destination
Disk on the bottom left is the
disk you want to install on, then
click Clean Install on the bottom
right. This installs a new system
folder and renames your current
folder to Previous System
Folder.

e If your computer came with an Apple
Macintosh CD:

Pg. 11

STEP ACTION
4 folder and renames your current
Cont. | folder to Previous System
Folder.

After performing a System 7.5 Clean
Install, when About This Macintosh is
selected under the Apple menu, it no
longer displays the specific Macintosh
name. Instead, it displays only
Macintosh, Macintosh Powerbook, or
Power Macintosh depending on which
system it is running on. If System 7.5 is
installed over an existing system (pre
7.5), it retains the specific Macintosh
name for the About This Macintosh
window. This holds true for future
Macintosh computers also.

A clean install of System 7.5 is now
complete.

Clean Install Troubleshooting

STEP ACTION

1 Open the System Software Install
folder on the Apple Macintosh CD
or click on the Install Software
button in the Launcher window.

2 Double-click on the System 7.5
Installer icon.

3 When the Welcome to System
7.5 message appears, click
Continue.

4 When the installer window
appears, press the 38-shift-K
keys simultaneously. You are
presented with a small dialog box
with two selections:

e Update Existing System Folder
¢ Install New System Folder

For a Clean install, select Install
New System Folder and click
OK. Make sure the Destination
Disk on the bottom left is the
disk you want to install on, then
click Clean Install on the bottom
right. This installs a new system

Verify Problem Resolution

After performing a clean installation,
verify that you resolved the problem
before adding anything to the new
System Folder. Adding items to the
System Folder before resolving your
problem defeats the purpose of
performing a clean installation.

Install Non-Standard Items

You can now reinstall the non-standard
items from the old System Folder (now
named Previous System Folder) such as
fonts, screen savers, and device drivers.
If possible, you should reinstall these
items from their original disks.

If the original disks are not available,
you may move the non-standard items
from the Previous System Folder to the
new System Folder. Be careful not to
replace anything that is already in the
new System Folder. Only move items

Continued on next page...
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that are not already in the new System

Isolate Incompatible or Corrupted
INITs in System Folder

Folder. Follow these steps to do this: STEP ACTION
TEP ACTION 1 Open the Control Panels from the
S €TI0 Apple Menu. Double click on the
1 Open each corresponding folder control panel called Extensions
within the System Folder and the Manager.
Previous S}yllstem Folder and then 2 Go to the pop-up menu that says All
compare the contents. On and pull it down to System 7.5
2 Move items not already in the new Only. This disables all non-standard
System Folder from the Previous extensions and control panels. Notice
System Folder. that the other items no longer have a
check mark by them. Close the
3 Restart your Macintosh. Extensions Manager.
3 Go to the Special menu and choose
Troubleshooting Extension Conflicts Restart.
. 4 Attempt to recreate the problem.
Any system extensions or control panels
installed appear as icons across the 5 If the problem does not occur, use
bottom of the screen when you restart. the Eﬁ“enSIOHS_Ma“ager to elnable |
They load into memory at startup time zggtreesrt;’,‘tt‘:ﬁ:‘&gc"i;fs:}fr‘;oﬁacnaen
and modify the standard behavior of the enable items in the Extension
operating system. Manager by clicking on the name of
the item so that a check mark
Verify Conflict appears.
. . 6 Attempt to recreate the original
If the Macintosh fails to restart or problem.

behaves erratically, you probably have
an incompatible or conflicting INIT (also
known as a system extension or control
panel). To verify this problem, follow
these steps:

STEP ACTION

1 Restart, and after you see the picture
of a computer with a smile, hold
down the Shift key.

2 Release the Shift key when the
Welcome to Macintosh,
Extensions Off message appears.

3 When the Macintosh is ready, try to
recreate the erratic behavior.

If the problem no longer occurs, then
you have a conflicting extension or
control panel. Continue with the steps
in the next section.

Repeat steps 5 and 6 for each item
listed in the Extensions Manager until
the problem recurs. The last item
returned to the System Folder is
probably the cause of the problem.

Final Steps

Verify that your applications are
performing normally. If not, refer to the
application manual or contact the
vendor.

When the Macintosh behaves as
expected and you are sure that all
needed items in the Previous System
Folder are transferred, move the
Previous System Folder to the Trash,
and choose Empty Trash from the
Special menu. @
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Transferring Macintosh Applicationsto UNI X

By Ed Rupp and Carl de Cordova

There are many third-party file transfer
protocol (ftp) utilities that let you
transfer Macintosh files (applications or
documents) from a Macintosh to any
UNIX workstation (Sun, HP, or A/UX)
running the Macintosh Application
Environment (MAE). This article
describes these useful utilities:

e fetch 2.1.2 (freeware)

e ftpd (shareware)

e VersaTerm PRO (commercial)
e NCSA Telnet 2.6 (public domain)
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Note:Use the correct format type when
doing transfers so either the data,
or resource forks are preserved
while transferring files between a
Macintosh and UNIX workstation.

Fetch

The fetch 2.1.2 utility is very straight
forward; it acts as an ftp client on a
Macintosh with MacTCP installed. It
supports these file format types:

e AppleSingle

e MacBinary I

e MacBinary Il

e BinHex4

e Stuffit Archives
e MacHost

The ftpd Utility

The ftpd utility acts as an ftp server on
a Macintosh with MacTCP. You can ftp
from a UNIX workstation (as an ftp
client) to a Macintosh.

For transferring Macintosh applications,
you should use the AppleSingle format
if your ftp utility supports it. If the ftp
utility does not support AppleSingle
format, you could use other utilities like
BinHex, MacBinary, and so on. First
convert the files to be transferred into
BinHex or MacBinary file format, then
use the binary transfer form in ftp. After
transferring to the remote UNIX
workstation, you may use the same
utility in MAE to convert them into their
original file format.

For people who do not have a floppy
drive on their MAE machine, getting the
fetch and binhex utilities mentioned
here can be a problem. The solution is
to log into ftp.abs.apple.com/pub/
mae/utilites and download the tar
archives of fetch, stuffit, and binhex.
The following read me is included in
this directory:

README for /pub/mae/utilities

Tools for Making Macintosh
Binaries Available to MAE

The utilities in this directory are helpful
if you need to transfer files between
Macintosh computers and UNIX
Workstations running MAE 1.0. This
README explains how to get and use
these tools.

Continued on next page...
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How to Download

There are 4 files in the utilities
directory on the ftp server called
ftp.support.apple.com:

/pub/mae/utilities/README

This file includes the text you are
reading.

/pub/mae/utilities/fetch.tar - (630K)

This is a tar archive of Fetch and Fetch
Help:

e Fetch 2.1.2 - (500K)

This is an ftp program that runs on
any Macintosh computer with
MacTCP installed.

e Fetch Help - (126K)

This is an optional file that includes
the complete manual on the Fetch
program. To use it, run Fetch with
this file in the same directory, and
pull down the Windows menu and
select Fetch Help.

/pub/mae/utilities/stuffit_exp.tar -
(83K)

This is a tar archive of Stuffit Expander
— Stuffit Expander 3.0.7 (81K). This is a
program that can unpack Macintosh
files in several formats.

/pub/mae/utilities/binhex4.tar -
(10K)

This is a tar archive of BinHex4 — BinHex
4.0 (8K). This is a program that can
encode and decode Macintosh files in
BINHEX (.hgx) format.

Enter the following UNIX commands to
uncompress the downloaded archives:

tar -xvf fetch.tar
tar -xvf stuffit_exp.tar
tar -xvf binhex4.tar

Example
Note:User input is shown in bold:

% Ftp
ftp> open ftp.support.apple.com

Name (ftp.support.apple.com:xxxxx):
anonymous

Password: <your email address>
ftp> cd /pub/mae/utilities
ftp> 1s

— directory list displayed —
ftp> binary

ftp> get fetch.tar

ftp> get stuffit_exp.tar
ftp> get binhex4.tar

ftp> close

ftp> quit

%

%

% tar -xvf fetch.tar

% tar -xvf stuffit_exp.tar

% tar -xvf binhex4.tar

Using Fetch

Run Fetch on a Macintosh computer that
is on the same network as your
workstation (that you use to run MAE).
When “get’ing a file, always select
binary transfer mode. When “put’ing a
file, on the final dialog select
AppleSingle as the file format. For
more complete instructions on using
Fetch, read the online Fetch Help.

Note:Any “put” file format besides
APPLESINGLE does not work.

There is an incompatibility that occurs
when running Fetch under MAE. After an
ftp transfer (get, put or directory listing)
has completed, Fetch does not
recognize the completion event and
waits (the dog cursor keeps running). To
manually correct this, just press the
Cancel button or press 88-. (period)
after the ftp transfer has completed.
Note that the Fetch Transcript window
(invoked from the Window menu)
displays a message when the transfer
has completed.

Continued on next page...
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Fetch is Copyright O 1994, Trustees of
Dartmouth College and is licensed free
of charge for use in educational and non-
profit organizations. Users in
government and commercial enterprises
may obtain an individual license for

$25. Please see the Fetch Help file for
more information.

Using Stuffit Expander

Stuffit Expander is a freeware Macintosh
application that can decompress and
decode a number of different formats
including Stuffit, Compact Pro,
AppleLink, and BinHex. This program is
also invoked automatically by Fetch
after the transfer process to decompress
archive files (Fetch can decode BinHex
files itself).

To use Stuffit Expander, drag the
archive or encoded file on top of the
Stuffit Expander icon or open the file
from within Stuffit Expander.

Stuffit Expander is free for non
commercial purposes and copyright
1992-1993 by Alladin Systems, Inc. and
Raymond Lau.

Using BinHex4

BinHex 4.0 is a freeware Macintosh
application that can encode and decode
files in BINHEX format. This is the most
common form of ASCII encoding and
transfer used for Macintosh files.

To use BinHex 4.0, launch BinHex 4.0
and choose Application -> Upload
from the File menu. Select the file you
want to encode from the standard file
dialog and save it (always make the
suffix .hqx to show it is a BINHEX file).
To decode a .hqgx file, choose Upload
—> Application from the File menu and
select the file to decode from the
standard file dialog and save it.

BinHex 4.0 is free for non-commercial
purposes and copyright by Mainstay.

Special ftp Note

hqgx files are the only files that can be
downloaded in ASCII mode; all others
must be downloaded in BINARY mode
for the file to decompress properly.
Otherwise you get errors like
“unreadable file” or “file is corrupt”
when you try to decompress them.

Legal Statement

These tools are being provided to you
“as is”. Apple assumes no responsibility
with regard to use of these tools. Apple
does not offer any warranties, assumed
or implied, regarding the usability and
reliability of these tools. Apple is not
responsible for any liability, direct or
indirect, that may arise from the use of
these tools. @

Tips and Tidbits

System 7.5 - System File

Make a copy of your System File
before doing this; use the copy to
try this out!

Look through the data fork of the
System File (with MacSnoop or
MacTools, or open it with MS
Word). (It’s short.) The string
“Help! Help! He’s STILL being held
prisoner in a system software
factory!” is in the data fork, along
with the name of the Blue Meanie,
those “Also serving time”, and
“Fugitives” (the various System 7
developers). Below the developer
names is “Will the last person to
leave please turn off the lights?”
About halfway down the file is
“The Cast” of “The Thread Manager
for 68K and PowerPC.” The cast
members all have humorous titles.
Below the cast list is the statement
“Dedicated to our fathers.”
[Contributed by Mike Erwin.] @
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Using GrayShare LaserWriter Printers

on a Network

From the Technical Information Library

This discussion focuses on sharing the
LaserWriter Select 300, Personal
LaserWriter 300, or the LaserWriter LS
printers over a network. To share one of
these printers, you must use the
LaserWriter 300 printer software.

Overview

You must use the LaserWriter 300
printer driver (which includes
GrayShare), to share your LaserWriter
printer with up to 21 additional
computers over an AppleTalk network.
There is no limit on how many people
choose the printer in the Chooser, but
only 21 people can simultaneously print
to the printer. Anyone who wants to
print to the shared printer needs to
install the LaserWriter Select 300 printer
driver. To print to a networked printer
from a Macintosh using System 6, you
must have System 6.0.7 or 6.0.8
installed, and use MultiFinder.

You still retain control of the printer
after sharing it because the LaserWriter
is connected to your computer. You can
turn sharing on or off at any time. You
can also use the Print Monitor program
to view a list of pending print jobs and
delete any jobs from that list.

Note:Your Macintosh connected to the
shared LaserWriter slows down
when other users print to the

shared printer because the
computer is actually being used as
a spooler. The information is sent
from the remote computer to
yours, then from your computer
to the printer.

Sharing a Printer

To share a LaserWriter Select 300,
Personal LaserWriter 300, or LaserWriter
LS with other users, follow these steps:

STEP ACTION

1 To share a printer, you must be
connected to an AppleTalk network
of some type.

e LocalTalk Connection

The LocalTalk connector goes into
the printer port. The peripheral 8
cable (serial cable) connects the
printer to the Macintosh. It needs
to go into the modem port.

e Ethernet or Token Ring Connection

Since both Ethernet and Token
Ring connections do not require
you to use a serial port. You can
use either the printer or modem
port to connect the printer to your
Macintosh.

2 Open the Chooser and select the
LaserWriter icon. A list of available
printers is displayed.

3 Click the icon of the port to which
your printer is connected. (If you are
using the printer port to connect
your Macintosh to the network, you
must connect your LaserWriter to the
modem port.)

4 Click the Setup button to open the
LaserWriter Sharing Setup dialog
box.

Continued on next page...
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STEP ACTION

5 Place an X in the Share this Printer
checkbox. You may choose to name
your printer and to enter a password.

If you type a password for the
printer, only users who know the
password can use the printer from
their computers.

If you want a record of what is
printed on your printer, place an X in
the Keep Log of Printer Usage
checkbox.

6 Click OK to close the LaserWriter
Sharing Setup dialog box and close
the Chooser window.

Your LaserWriter is now available to
other users on the network.

Printing to a Shared Printer

To print to a shared LaserWriter Select
300, Personal LaserWriter 300, or
LaserWriter LS follow these steps:

STEP ACTION

1 Open the Chooser and select the
LaserWriter 300 icon. A list of
available communications ports and
printers is displayed.

2 Click the name of the shared
LaserWriter you want to use. If the
printer requires a password, a dialog
box appears; type in the password.

3 You may click the Get Info button to
see whether any fonts in your system
are unavailable on the shared printer.
If your documents use such fonts,
printing is slower, because the fonts
must be downloaded to the printer.

4 Close the Chooser.

You are now ready to print to the shared
LaserWriter Select 300. @

Apple Personal

Diagnostics Emer gency
Disk Fulfillment

By Stephanie Hahn

If you use Apple Personal Diagnostics
(APD) Version 1.0 on one of the system
configurations listed below, you may
encounter a situation that requires an
emergency disk not included in the APD
package. Please call 1-800-769-2775,
extension 7855, and request that the
appropriate disk be mailed to you.

Note:There is no fee to cover shipping
and handling.

System Configurations Affected

The emergency disk called APD
Emergency Disk 3 — Miscellaneous
Macintoshes supports these systems:

e Macintosh Quadra 610

e Macintosh Quadra 650

e Macintosh Quadra 660AV

e Macintosh Quadra 800

e Macintosh Quadra 840AV

e Centris 610

e (Centris 650

e (Centris 660AV

e Macintosh TV

e Apple Workgroup Server 60
e Apple Workgroup Server 80

The emergency disk called APD
Emergency Disk 4 — 800K Drives Only
supports any Macintosh CPU that does
NOT have a 1.44 MB floppy drive.

Version 1.1 of Apple Personal
Diagnostics comes with emergency
disks that cover all Macintosh models
except the Workgroup Server 9150. @
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Turning Off Layer Hiding

From the Technical Information Library

There is a feature in System 7.x for the
Performa and for System 7.5 called layer
hiding. This feature hides the
background windows, showing only the
active window.

System 7.5

Under System 7.5, layer hiding is part of
the General Control panel. To prevent
layer hiding:

STEP ACTION

1 Open the General Control panel

2 Click the Show Desktop In
Background box

3 Close the General Control panel

system software, the layer hiding
feature is built into the Launcher
application.

To prevent layer hiding, remove the
Launcher control panel from your
Control Panels folder. If you place the
Launcher control panel in another
location, you can still use it, but the
layer hiding feature is disabled.

After you move the Launcher control
panel, you need to restart your
computer.

System 7.1P3, 7.1P5, and 7.1P6

Under these versions of the Performs
system software, the layer hiding
feature is built into the Performa control
panel. To prevent layer hiding:

Here are examples of both views of the
applicable portion of General Control
panel:

STEP ACTION

1 Open the Performa control panel

2 Click the Finder Hiding button

S[I=—— General Controls = 3 Close the Performa control panel
Desktop
After you close the Performa control
(] Show Desktop when in background panel, you need to restart your
computer. @
EI=——— General Controls == Tips and Tidbits
Desktop Apple Media Tool: Running
_ PICT Files in Sequence
E Show Desktop when in background
To have a series of PICT files
appear in sequence (with a

After you close the General Control
panel, you need to restart your computer

Older Versions of System 7.xP

System 7.01P, 7.1P, and 7.1P2
Under these versions of the Performa

duration set for each PICT image)
close the Screen window before
running. Otherwise, the screens
may not run properly. Always run
tests from the Map window with
all Screen windows closed. )
[Contributed by Philip Jones.] @
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System 7.5 Performa Softwar e | ncompatibility

By Bob Wambaugh

Macintosh Performa computers come
with a lot of software already installed.
If you install System 7.5 on your
Performa using the Safe Install
application, Safe Install reports that
some of the applications are not System
7.5 compatible. (These applications are
listed in the following table.)

The testing of System 7.5 and bundled

software has been ongoing since August
1994. As software is tested it is either
confirmed as compatible with System
7.5, updated with a compatible version,
or removed. This is true for both Apple
and third party software.

In regards to the specific software listed
as incompatible by Safe Install, the
latest information is listed in the right
column of the following table. @&

Performa Software Incompatibility Table

Product | Version Developer Compatibility Information

At Ease 2.0 Apple Computer Incompatible need newer version 2.0.3. (See the

Startup following section, titled Obtaining At Ease
2.0.3))

Billminder unknown Intuit, Inc. Should be ok; database needs updating.

Macintosh 1.0.4 Apple Computer Incompatible; gets replaced by 7.5 installer with

Easy Open vl.1.

Performa 1.4P Apple Computer Gets removed by 7.5 installer and replaced with
General Controls.

ProDOS File 1.2.1 Apple Computer Incompatible needs to be removed; PC Exchange

System 2.0.2 includes ProDOS File System capabilities
and is installed by 7.5.

Video Startup | 1.0 Apple Computer Should be compatible; database needs updating.

Obtaining At Ease 2.0.3

You can obtain a copy of At Ease 2.0.3 in
the Apple Software Updates area on one
of these online services:

e AppleLink (path: Software Sampler 0
Apple SW Updates)

e eWorld (shortcut: acc; path: Computer
Center O Apple Customer Center O
Apple Software Updates)

e ftp.support.apple.com (path: pub O
Apple Software Updates)

e ftp.info.apple.com (formerly

ftp.austin.apple.com) (path:
Apple.Support.Area O
Apple.Software.Updates)

e info.hed.apple.com (Apple Higher
Education gopher server) (path:
Apple.Support.Area O
Apple.Software.Updates)

At Ease 2.0.3 is located in the following
path on the preceding systems:

Macintosh O System Software O Other
System Software. @
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Tell Us What You Think

Tell us what you think of the Information Alley. We want the Alley to be as useful for you as possible. Your feedback
will help us reach this goal. Please fill out this form and fax, mail, or email it to the address at the bottom of this page.

Content
Were the articles interesting and informative? YES NO If NO, please explain:

How was the technical depth of the articles? NOT ENOUGH ABOUT RIGHT TOO MUCH
Comments:

Did you find any specific article especially useful? YES NO If YES, list which one:

How is the frequency of the magazine? TOO OFTEN ABOUT RIGHT NOT OFTEN ENOUGH
Comments:

How is the length of the magazine? TOO LONG ABOUT RIGHT NOT LONG ENOUGH
Comments:

Format and Layout

Is the format and layout easy to read and follow? YES NO If NO, please explain:
Do the graphics enhance or clutter the magazine? ENHANCE CLUTTER
Comments:
Did you read the magazine online or did you print a copy? ON-LINE PRINTED COPY
Comments:

Please describe ways in which the Information Alley could be improved, or give us your ideas on future articles.

Personal Information (optional)

Please let us know who you are in case we have questions about your suggestions or comments.

Name Telephone

Company Email

Address

City State  Country Zip

Type of computer(s)

Primary software applications:

Information Alley, 1200 East Anderson Lane, MS: 212-STI, Austin, TX 78752 — email: alley@apple.com; fax: (512) 908—8018"
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